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BRADLEY SOFTWARE

The Bradley ArrearsMaster™ Calculator

An important component is often overlooked
in collecting unpaid support obligations for
child support and alimony (spousal
maintenance) — the interest which is
automatically earned on every support
payment which is not fully paid on time!

Overlooked interest can form a substantial
part of the total amount due — particularly
in states (like Kansas) where support
payments are first applied to the current
month’s support, then to unpaid interest,
and only then to unpaid support arrears
(which continue to earn interest !)

The Bradley ArrearsMaster™ program is
constantly updated to reflect changes in
applicable state interest rates. The program
presently includes rates for KS, MO, MN,
NE, OK, and FL.The interest rates
applicable are automatically determined by
transaction date. New states are being
added as requested.
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A Program Tour

All Bradley Software products can be
downloaded as “Free Trial versions” from
our website. These trial versions are the real
live working programs, but some of the
features have been turned off or limited. This
“free trial” concept provides a way for you to
get a feel for how the program works before
purchasing. However, many discerning
buyers would rather review a document
explaining the features before they even try
the trial programs.

To that end the following pages are intended
to provide an idea of how easy the program
IS to run and yet how flexible it is.

What follows is to some extent more of a
users guide than an program tour. We've
done this so that after you have downloaded
the “Free Trial version” you'll be ready to
create an accurate Arrears report in no time.



The Main Program Screen
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Case Data Page

The first page presented when the program starts is the Case
Data page. Here you will enter court and case general information
to particularize the report file.
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The Case Data page is also where you will select which state’s
interest rates will be applied when calculating interest on the
arrearage. If a particular state is not included in the interest rules of
the program, a warning is presented. We will be happy to add the
interest rules for any state at no cost and update the program for
free -- just let us know what you need!!
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Support Obligations Page

The Support Obligations page simplifies entry of the support
obligations details with enormous savings in time and effort, while
minimizing the potential for erroneous entries. Simply enter the
starting date for a support order, the amount, and the frequency of
payment required. The ArrearsMaster will then generate the
transactions automatically!

The Beginning Date, Calculate Interest Through, Balance Forward
and Interest Forward fields are also used to address a variety of
situations.

% ArrearsMaster™ 10l =l
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Eeginning Date I 04/01/1533 :I Calculate Interest Through I 1072772004 :I
Ealance Fonward I ¥ :I Interest Fonward | o :I
Child Support Maintenance
Date Aot Freguency Date Amovnt Freguency
04401393 380 Marithly 044014393 1200.00 Marithly
0401 2002 765 Marithly 080172002 i] End-Date
OF 2512004 Ju] End-Date
Press EMNTER to maove ta the MEXT cell in the Grid
To add & rovy - Press ENTER wehils inthe bottom right el Sort Mext Page |
To deletedclear & rowy - RIGHT Click on a cell in the rovy to modify
Caze Data Support Obligations Payments and Adjustments I Report

You can enter transactions in any order. The SORT button
sorts the entered transactions by date.
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Understanding Transaction Frequency

Child Support
Date Amaunt B The Frequency selector
04/011995 380 Monthiy specifies the interval used
04/01/2002 765 Morthly to generate transactions for
071262004 0 EdDste 7] a particular support order.
Weekly
Eﬂﬁﬁﬁj"? It is far faster than entering
Semi-manthly each obligation separately
Single

W In a spreadsheet program.

In the above example, the top row reflects an order that begins on
04/01/1998 for $380 per month. When the report is generated, it
contains 48 transactions, each for $380 on the 1st of every month
between 04/01/1998 and 03/30/2002. The last transaction of $380
falls on 03/01/2002, just before the first $765 payment due under
the next support order, which becomes effective on 04/01/2002.

The Frequency settings are:
 Weekly - one every 7 days (52 times per year)

» Bi-weekly - every two weeks on the same day of the week
(26 times per year)

 Monthly - 12 times per year

« Semi-monthly - two times per month (24 times per year)

e Single - one transaction only

 End Date - ends the obligations of the last listed support
order without a new support amount — e.g., on emancipation.
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Payments and Adjustments Page

The Payments and Adjustments page is set up for speedy entry of
information about payments made. Each payment or adjustment is
individually entered. Transactions can be entered in any order.

% ArrearsMaster™ E ] ]
File Edit Wiew Preferences Help
slE=EIEENE]
Fayments Adjustments
Date Aot Date Amount Adjustmernt Type
04/01/1338 1000.00 0zMa/2004 -500
05111338 1200.00
06111338 900.00
09/06,/1335 1400.00
10M0/1333 3000.00
03/03/2000 467
07128/2000 EO0
062072004 EES
To add & rowy - Press ENTER wwhile in the bottom right cell. =it | Mgt Pane |
To deletesclear a rovy - RIGHT Click on a cell in the rowve to modify
Casze Data Support Obligations | Payments and Adjustments Report

The SORT button sorts the entered transactions by date and
removes any incomplete transactions.
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Report Page

Generating an arrearage schedule is as easy as clicking on the
report page. All information entered on the other pages is
organized, the interest is calculated, and the report. Is created.

The column headings stay in view for easy review of the data.
Zooming in or out is as easy as a left click (zoom in) or a right
click (zoom out).

The report is WYSIWYG The ZOOM icons are active
(“What you see is what you when on the Report Page.
get” when you print). Itis
easy to review and make
changes before printing.

% ArrearsMaster™ . 10l =l
File Edit Wiew Preferences Help
sIEEIEIEEEENEY
Jobn Smith Randy Spiwey -
in RE Marriage of Smith Spivey's Firm I—
Johnson County 29945 w 95th Street b
Caze Mo, 90 C 900209 Suite 1
Le 50OTO, K5 GG015
Kanzas interest rates have been applied . Copyright 2004 - Bradley Sofbware LLC (9137 §23-0245
|
[rate Item Amount Amount Fayment Applied to Interest an Armrears (1)
Due Faid Current Interest Support Annual | Fer Diem [ £
Support | HAurears Rate [ % | B | [rays
04011992 Balance Fud 0.00
M998 Child Support Fg0.00 0.oo0 0.0 0.0 0.00% 0.0245% 3§ 0.00000
4i1/988 Maintenance 1,200.00 0.00 .00 0.00 9.00% 0.0246% § 000362
M998 Fayment 1,000.00 1,000.00 0.0 0.0 0.00% 0.0245% § 038032 -
51998 Child Support 320.00 0.00 .00 0.00 9.00% 0.0246% §0.14202 e
S/MM898 Maintenance 1., 200.00 0.oo0 0.0 0.0 0.00% 0.02495% F 014292 -
5111998 Fayment 1,200.00 1,200.00 .00 0.00 9.00% 0.0246% § 030932 1
G998 Child Support 2000 000 o.o0 0.0o0 0.00% 0.0Z496% F 022655
GMME98  Maintenance 1., 200.00 0.oo0 0.0 0.0 0.00% 0.0245% F 023655 -
Gi11/1998 Fayment Q00.00 200.00 .00 0.00 9.00% 0.0246% 038932 1
7/1/1002 Rate Change . 000 0o 0.0 onow  oozass[ Fo.a0a111 21
7/1M938 Child Support 350.00 0.00 0.00 0.00 0.00%  0.0245%  FoonaTT .
FHME98  Maintenance 1., 200.00 0.oo0 0.0 0.0 0.00% 0.0245% F 040411 -
201998 Child Support 320.00 0.00 .00 0.00 9.00% 0.0246% §0.792342 3
8MM898 Maintenance 1., 200.00 0.oo0 0.0 0.0 0.00% 0.02495% F 079343 -
21998 Child Support 320.00 0.00 .00 0.00 9.00% 0.0246%  §1.18275 3
9MMe88 Maintenance q.200.00 000 o.o0 0.0o0 9.00% 0.0295%  F1.18275 -
Q51998 Fayment 1,400.00 1,400.00 0.0 0.0 0.00% 0.0245% F1.18275 ER
4 | i1
Caze Data Suppaort Chligations Payments and Adjustments Report
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The Printed Report

The ArrearsMaster™ prepares a schedule showing all obligations
and payments, in chronological order, with interest. The report data
reflects the state for which the interest calculations are prepared.

State for which
Interest calculations
are based

/

Client Attorney name and
information information

0.00 ssu/ Randy Spivsy /
in RE Marmage of Smith Spivey's Frm
Johnson County 20945 w 25th Street
Casz No 00 C 009000 Suite 1
De 5070, KS 66013
Kansas interest rates have been applied . Copyright 2004 - Bradley Sofiware LLC (013) 583-Ds48
Date lbem Amount Amount Payment Appled to nterest on Amears (1) Ealances
Dus= Faid | Current Imte Support | Annual | Per Diem Adged
Support Arrears Rate | % | g | Days | Amt Current Manith | Interzet | Arrears
04/01:2004 Balance Fad D.00
4/112004 Child Support 280.00 0.00 0.00 0.o0 8.00% 0.0184% § 0.000I 0
512004 Child Support 3E0.00 0.00 0.00 0.00 8.00% 0.0 50 30 a
8/1/2004 Chikd Support 2ED.0D 0.0o0 41428 8.00% 0.0 % 50.12483 31 a
8/18/2004 Adjustment {8D0.00) 0 o.oo @ 50. 17 1
@20/2004 Payment @60.00 237 66363 [:] 501 2 0.25
7112004 Rate Change - 0.00 0.00 [ 50 1 0.00
THi2004 Child Suphport 3ED.0D 00 0.00 [:] 50 - 0.00
2112004 Child SupRrt 280.00 0.o0 8 50 Bl 202
9/1/2004 Child Supp 3E0.00 0.00 [:] 50 31 4.02
10/1/2004 Child Suppo 380.00 0.00 0.00 0.o0 8.25 50 30 5.85
10/27/2004 Report End - 0.00 0.00 0.00 .25 50 28 (W]
Totals N260.00 560.00 - E 11 1 08058 25.08
We hold the United States Ruls is N\ot app\¢able 1o child support payments which are Underlying orders
not cverpaid. Such payments are edzeption 1o that rule. However, since the paries Date Type Amaount
made no cheice about overpayments\we conNyde the United States Rule [228 Kan. 08] 04012004  Child Support 330.00
is appicable o such payments. Inthe\gbsence Xf direction from either the debtor or
creditor, overpayments of child support §hall be soglied firstio interest then to overdus
support dating back 1o the sarliest nendoNnant juzgient.
Dallaz v. Dallas, 236 Kan. 22, 62% P 2d 1134 (1224)
(1) AN refsailis calculated to 15 decimal place fNecsion.

/ I Grand total
Important due summary
WolED Detailed transaction on last row

information area showing

each transaction and
corresponding interest Summar_y o
calculations. Transactions Underlying
are sorted by date. orders
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Features of the Main Toolbar

!‘ ArrearsMaster™

File Edit View Preferences Help

= EEE RN

Using the quick-access icons on the toolbar, you can
(from left to right):

* Open a new interest calculation file
* Open an existing interest calculation file
« Save the current interest calculation file

e Save the current interest calculation file under a
new hame

* Print the calculation report for use in court,
mediation, or negotiations

» Toggle the calculator and calendar drop down
features on or off.

» Edit the report header and footer.

 The two ZOOM buttons (magnifying glass with + or
- sign) only appear while on the Report page.

BRADLEY SOF Pg 11




The pull-down menus

The FILE Menu

Q‘ ArrearsMaster™

File Edit Wiew Preferences Help

Mew

Open
Save

Saveds

Page Setup
Printer Setup
Print

1 - c:\PROGRAM FILES\ERADLEY\SUPPOR TYEvaluation. AMs

Z - Ci\Program Files\Bradley, SUPPOR Tibalforwardonly, ars

3 - @:iBradley Software) Comunications) 2004, 2004-09-25Drussel, AMS
4 - Z:Program FilesiEBradley SUPPOR T def ault, AME

& - .:iPROGRAM FILES\ERADLE\SUPPOR TYEvaluation. AME

& - Z:'Program Files\Eradley SUPPOR T test, AMS

7 - Z:'Program Files\ERADLE ', SUPPOR TAEvaluation, AMa

8 - @ BRADLE~2YCOMUNI~ 1420041 201 C26e1 \ WEDEBR.~1, AMS

Exit

The FILE menu gives you
access to features related to
managing interest calculation
files. You can open a new or
existing file, save or save as
another name. Printing and
printer set up is also done
here. Page setup allows you to
control page header and footer
text.

The last 8 files opened are
also listed here for quick
access to them.

The Edit menu is where you
can add or remove rows of
transactions. Just highlight a
grid row then select what you
want to do.

The Edit Menu

w- ArrearsMaster™
File | Edit Wiew Preferences

Clear Fow 3
El‘[ Delete Fow @

The VIEW Menu

File Edit | Wiew Preferences Help

0 ||=’:| E_ Case Motes _Il & | a‘l
|

BRADLEY SOF

The View menu generates the
case notes for this arrears file.
This is a quick way to document
special issues about the current
arrears calculation.
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The pull-down menus (cont’d.)

The HELP Menu

File Edit Miew Preferences | Help

Dlﬁlglﬁl%lalJl Help Topics F1

Check Internet For Program Updates

Transfer License

To Purchase a license *
Feedback via Internet F1z
Contact Bradley Software

About the Bradley ArrearsMasker™

Using the HELP menu you can:

Get HELP - full context sensitive help for the
program

Check Internet for Program Updates - this checks
our website for the most current updates.

Register, transfer, or purchase a license.
Provide feedback to Bradley Software

Contact Bradley Software or get version
information.

Note: The program also includes an auto-update features that
will automatically check our website for updates every 30 days.

BRADLEY SOF Pg 13




Preferences

Using the PREFERENCES screen, you can
customize the program to fit your practice
and office organization

Arrears™Master™ 2004

SaveExit | Exit Help

Yalues for Current Calculation Only

[913) 583-984E

Apply payment to current suppaor
and then to:

IInpaid Interest - Child Support -

Yalues for ALL Calculations

c\PROGRAM FILESYERADLEYASLUPPORTY

bz whien opened

Cancel

Payment options The Other Settings area is

« Control how the payments used to :

are applied Control the display of the
splash screen upon program

» Controls the priority of the
start-up

payment.

Control how the attorney
name is displayed

Control the column heading
BRADLEY SOFTWAF display Pg 14
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Program minimum requirements

The minimum system requirements to run
the Bradley ArrearsMaster™ Calculator are:

* Pentium processor 300mhz or
equivalent

e 20mb free hard disk space

* 128mb RAM (more is always better)

 display monitor capable of 800 x 600
(SVGA)

» Windows 98, 98SE, Me, 2000, XP
Home, XP Professional or Windows
NT4.0 (SP6a only). Be sure that all
available "service packs" have been
installed.

* Internet Explorer version 5.5 or
greater is REQUIRED.

* Macintosh OS is also supported if
Microsoft "Virtual PC" for the Mac is
installed. Find it at
http://www.microsoft.com/mac/

The program is available in standalone and
networked versions.

Pg 15
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Try
The Bradley

ArrearsMaster™

Calculator

Download a
Bradley Software LLC .
9300 W. 110th, 55 Corporate Woods 500 free trial from
Overland Park, Kansas 66210
USA www.bradleysoftware.com

Contact us: inquiries@bradleysoftware.com
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